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 1نکته  □
 SPSS افزارنرممعرفی 

SPSS  مخففStatistical Package for the Social Sciences با خرید  .باشدمیSPSS 

 تغییر یافت. IBM SPSSرسمی به  طوربهبه بعد نام آن  ۹۱از نسخه  IBMتوسط 

 

 ۲نکته  □
 SPSSانواع فایل در 

  فایل داده یاdata  با پسوند.sav 

  فایل خروجی یاoutput  با پسوند.spv 

  فایل سینتکس یاsyntax  برای کد نویسی با پسوند.sps 

 

 ۳نکته  □
  هافایلپسوند  شینما

 Hide known نهیگز سپسو  Control Panel→Folder Options→View Tabر مسی ۷ ندوزیو در

file types دیینما یرا بررس . 

 

 ۴نکته  □
 داده پنجره معرفی 

 

 : پنجره معرفی داده۹ شکل



SPSS 

 

 5نکته  □
  variable viewپنجره 

 
 variable View: پنجره 2 شکل

 

 6نکته  □
 variable viewپنجره  یاجزا

، Name ،Type ،Widthقسمت  ۹۹داده  بوده و شامل  لیدر فا رهایمتغ هایویژگی نییتع یپنجره برا نای

Decimals ،Label ،Values ،Missing ،Columns ،Align ،Measure  وRole باشدمی. 

 

 ۷نکته  □
Name 

 باشدمی ریاز متغ صیقابل تشخ یمختصر ول حیتوض. 

   یخال یضاکاراکتر مجاز بوده و رها نمودن ف 46حداکثر تا (spaces) ژهیو یو استفاده از کاراکترها 

(special characters) باشدمیمجاز ن. 

 شده است. هیتنها استفاده از حروف و اعداد توص 
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 8نکته  □
Type 

  عددی، حرفی یا تاریخ باشد. تواندمینوع متغیر بوده و 

 نوع متغیر در  فرضپیشSPSS ( عددیNumericبوده و تغییر آن توص ) شودنمییه. 

 بجای استفاده از حروف  مثالعنوانبهf  وm  استفاده گردد. 2و  ۹برای تفکیک جنسیت از اعداد 

 

 9نکته  □
Width 

  باشد به پهنای بیشتری نیاز خواهد بود. رتبزرگهر چه عدد 

  باشدمی 8، فرضپیشپهنای. 

  ،چنانچه پهنای انتخاب شده کمتر از میزان مورد نیاز باشدSPSS عداد را گرد خواهد کرد.ا 

  گذاردنمیتغییر پهنای متغیر تأثیری بر دقت محاسبات  . 

 

 11نکته  □
Decimals 

  این گزینه تعداد اعشار را در پنجرهData View  سازدمیمشخص. 

   باشدمی 2، فرضپیش طوربهتعداد اعشار. 

 SPSS  دهدمیشده انجام رقم اعشار بدون توجه به تعداد اعشار مشخص  ۹4محاسبات را تا. 

 

 11نکته  □
Label 

 ( برچسب عبارتیphrase برای توضیح بیشتر متغیر )باشدمی. 

  ًاندازهبهچنانچه نام متغیر  معمولا ( کافی گویاdescriptive باشد، از این گزینه صرف نظر )شودمی . 

 SPSS  دهدمیدر برونداد، کنار نام متغیر گزارش  صرفاًو  کندنمیبرچسب را تفسیر. 

 

 1۲نکته  □
Values 

 کاربرد دارند یبیو ترت یاسم یرهایدر متغ یمقدار هایبرچسب. 
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 مییاستفاده نما یاست از برچسب مقدار یضرور نید ای ییایمنطقه جغراف ت،یجنس کیتفک در. 

 ندارد. یضرورت یو اسم ایفاصله یرهایمتغ ینوع برچسب برا نیاز ا استفاده 

 

 1۳نکته  □
Missing 

 باشدمیهنگامی کاربرد دارد که علت مفقودی مهم  رفتهازدست مقادیر . 

 د.  استفاده نمو شودمی رفتهازدستاز مقادیر  ایگسترهیا در ترکیب با  تنهاییبهگسسته  صورتبه 

  ی معتبر باشد.هادادهعدد استفاده شده نباید در محدوده 

 

 1۴نکته  □
Columns 

 عرض ستون در پنجره میتنظ منظوربه View Data کاربرد دارد. 

 شودمیمشاهده  شیمایدر نوار پ رییبدون تغ رهایاز متغ یشتریکاهش عرض ستون تعداد ب با. 

 نباشد.   رینام متغ یعرض ستون کمتر از تعداد کاراکترها شودمی هیتوص 

 

 15نکته  □
Align 

 متن در خانه جدول مشاهده داده میتنظ یبرا (Data View) کاربرد دارد. 

 قابل انتخاب هستند چینوسطراست، چپ و  هاینهگزی. 

 باشدمی چینراست فرضپیش. 

 

 16نکته  □
Measure 

  شودمیمشخص  رهایمتغ گیریاندازهسطح.  

 یموجود اسم هایگزینه (Nominal)یبی، ترت (Ordinal) ایفاصلهو  یو نسب (Scale) هستند. 

 کاربرد دارد. یاملتع ینمودارها جادیهنگام ا گیریاندازهسطح  میتنظ 
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 1۷نکته  □
Role 

 یمختلف هاینقش (Input, Target, Both, None, Partion & Split) داد توانمی رهایبه متغ. 

 فرضپیش Input وارد شود لیکامل در تحل طوربه ریمتغ دهدمیکه اجازه  باشدمی. 

 شودنمیداده  فرضپیشدر  یرییتغ. 

 

 18نکته  □
 و موارد رهای، متغهاداده: یآمار میمفاه

 ّنامندمیپژوهش  یهادادهرا  شوندمیحاصل  جینتا هاآنثبت شده که بر اساس  یفیک ای یمشاهدات کم. 

 باشدمی گیریاندازهقابل حالدرعیناست که اندازه آن متفاوت و  یمقدار ریمتغ.  

 

 19نکته  □
 گیریاندازه: سطوح یآمار میمفاه

 سازندمیرا مشخص  گیریاندازهسطوح  ،هادادهروش ثبت  ای اسیمق.  

 هستند هاداده یآمار هایقابلیتمنعکس کننده  گیریاندازه سطوح. 

 در  سطوحSPSS باشدمی یاسیو مق یبیترت ،یشامل اسم. 

 

 ۲1نکته  □ 
 یاسم یهاداده: گیریاندازهسطوح 

 ندارند یخاص یتنها برچسب بوده و معن یاسم یهاداده. 

 گیرندمیمورد استفاده قرار  یبه کمّ یفیک یهاداده لیتبد یبرا. 

 باشدمیقابل گزارش  یفراوان ینمود ول گیریمیانگین شودنمی هادادهنوع  نیا در.  

 هستند. یداده اسم یماریتأهل، شاغل بودن و سابقه ب ت،یجنس 

 

 

 



SPSS 

 

 ۲1نکته  □
 یبیترت یهاداده: گیریاندازهسطوح 

 شوندمیخاص استفاده  یگژیو بندیرتبه یبرا هاداده نیا. 

 باشدمیمشخص ن هارتبه انیمطلق م تفاوت.  

 هست یبیترت یهادادهسنجش  هایروشاز  یکی کرتیل فیط.  

 باشندمی یبیترت یهادادهجزء  یسفت ای یخشک ت،یرضا زانیدرد، م احساس. 

 

 ۲۲نکته  □
 یو نسب ایفاصله یهاداده: گیریاندازهسطوح 

 (ی)نمره درس باشندمی یصفر قرارداد یاراد ایفاصله یهاداده 

 (صفت مورد سنجش هست )درآمد زانیم انگریمطلق بوده و ب ینسب یهادادهدر  صفر 

 SPSS  مق وهیش کیبا هر دو داده به(ای یاسی Scale رفتار )کندمی. 

 

 ۲۳نکته  □
 وابسته ریوابسته و غ هایطرح: یآمار میمفاه

  د ویژگی گروهی خاص )مرد یا زن( در یک مقطع زمانی یا در طول زمان اندازه وابسته یا همبسته چن هایطرحدر

 . شودمیگرفته 

  سی خونی مختلف( برر هایگروهخاص )مرد و زن یا  هایگروه هایویژگییا غیرهمبسته  غیر وابسته هایطرحدر

 .شوندمی

 SPSS  کندمیرا بررسی  هاطرحی این هاداده متفاوتبه شیوه. 

 

 ۲۴نکته  □
 مفاهیم آماری: آمار توصیفی

  کندنمیتوجهی  هاتفاوتآمار توصیفی به شرح وضعیت وجود پرداخته و به دلایل. 

  میانگین، نما، میانه، فراوانی، دامنه،  شودمیدر چند شاخص استفاده  هادادهاز این آمار برای خلاصه نمودن(

 (. حداقل و حداکثر
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 رساندمییاری  این آمار به شفاف شدن چارچوب مطالعه. 

 

 ۲5نکته  □
 ی: آمار استنباطیآمار میمفاه

 شوندمیآماری با توجه به اهداف پژوهش انتخاب  هایروش. 

 شودمیتهیه  هافرضیهتجربی و متکی به شواهد برای  هاییپاسخ . 

  تند. سآمار استنباطی ه هایخروجیتعیین میزان تفاوت، کیفیت ارتباط و بررسی روابط علیّ و معلولی از 

 

 ۲6نکته  □
 و فرض صفر هافرضیهمفاهیم آماری: 

 باشدمینتایج پژوهش بر اساس اطلاعات موجود  بینیپیش. 

 ی پژوهش )هافرضیه هاینامبا  هافرضیهResearch Hypothesis( تجربی ،)Experimental 

Hypothesis( و جایگزین )Alternative Hypothesis شوندمی( شناخته . 

  شودمیبرخلاف فرضیه پژوهش طراحی فرضیه صفر. 

 

 ۲۷نکته  □
 دوطرفهو  کی یهافرضیه: یآمار میمفاه

  شودمیو جهت ارتباط آزمون  داریمعنیهمزمان  طرفهیکی هافرضیهدر. 

  توجه بر وجود ارتباط است.  دوطرفهی هافرضیهدر 

 شوندمیاستفاده  ندرتبه طرفهیک هایآزمون. 

 

 ۲8نکته  □
 : جامعه و نمونهیآمار میمفاه

 ( جامعهPopulation همه مشاهدات محتمل برای متغیر مورد بررسی را در بر )گیردمی. 

  نمونه(Sample ) شودمیبخشی از جامعه بوده و نتایج حاصل از آن به جامعه تعمیم داده. 

  شودمیچنانچه عناصر جامعه محدود باشد، تمام شماری انجام. 
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 ۲9نکته  □
 هاآمارهارامترها و : پیآمار میمفاه

  باشندمیجامعه  هایویژگیپارامترها مقادیر واقعی. 

 آماری برای برآورد یا آزمون پارامترها با استفاده از اطلاعات نمونه هستند. هایروش هاآماره 

  یابدمیپارامترها ناشناخته بوده، در نتیجه دقت برآورد اهمیت. 

 

 ۳1نکته  □
: احتمالاتیآمار میمفاه  

 باشدمیواقعی از جامعه مورد بررسی  اینمایندهه تا چه اندازه نمون. 

  مربوط است. گیرینمونهتفاوت مشاهده شده تا چه اندازه به شانسی بودن فرآیند 

  آماری میزان احتمال یا مقدار  هایآزموندرp  شودمیگزارش. 

 

 ۳1نکته  □
 داریمعنیمفاهیم آماری: 

 p صحت فرض صفر(. سازدمیشانسی باشد را مشخص  تواندمیچه میزان یزان احتمال اینکه نتیجه به م( 

  چنانچهp  قبول کرد.  توانمیکمتر از پنج درصد باشد، شانسی بودن نتایج را نمحاسباتی 

  دارمعنیبا رد فرضیه صفر، نتایج (Significant گزارش )شوندمی. 

 

 ۳۲نکته  □
 یمجانب داریمعنی: یآمار میمفاه

 مج داریمعنی( انبیAsymptotic در مقابل یک توزیع مجانبی آزمون )شودمی. 

 ودشنمیصفر  گاهچیهمجانبی توزیعی است که احتمال مقادیر بسیار بالا یا بسیار پائین  عیتوز. 

 .توزیع نرمال یک توزیع مجانبی است 
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 ۳۳ هنکت □
 یواقع یداری: معنیآمار میمفاه

 های بزرگ پیشنهاد شده است.مونههای مجانبی برای ناستفاده از توزیع 

 شود )مانند آزمون دقیق فیشر یا داری واقعی استفاده میهای کوچک از معنیبرای نمونهFisher’s exact 

test.) 

  گردد.استفاده از آزمون واقعی اشاره میبه  در تحلیل نتایج 

 

 ۳۴نکته  □
 نانی: سطوح اطمیآمار میمفاه

 ای توصیه شده است.ای برآوردهای نقطهجاستفاده از سطوح اطمینان به 

 .سطوح اطمینان دارای حد بالا و حد پائین هستند 

 کنندرا تعیین می رود مقدار واقعی در آن قرار گیردای که انتظار میحدود بالا و پائین دامنه. 

 

 ۳5نکته  □
 نانی: مثال سطوح اطمیآمار میمفاه

  باشد، در آن صورت احتمال قرارگیری  3و  2ی متغیری به ترتیب ، حد پائین و بالا0/۱9چنانچه در سطح اطمینان

 باشد.درصد می ۱9پارامتر مورد بررسی در دامنه مذکور 

  قرار خواهد گرفت. 3و  2مورد پارامتر در محدوده  ۱9گیری انجام داده شود، در بار نمونه ۹00یعنی چنانچه 

 

 ۳6نکته  □
 نانمفاهیم آماری: مزایای کاربرد سطوح اطمی

 گردد.دامنه برآورد از مقدار واقعی پارامتر مشخص می 

 رسی نمود.ها برتوان میزان همپوشانی متغیرهای مختلف را هنگام رسم میانگینبا استفاده از سطوح اطمینان می 

 شود.سادگی فراهم میامکان آزمون فرضیه به 
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 ۳۷نکته  □
 (effect size: اندازه اثر )یآمار میمفاه

 (.هاگینمیان)اندازه تفاوت  کندمی گیریاندازهمتغیر مستقل بر متغیر وابسته را  تأثیرثر، میزان اندازه ا 

 شودمی. این مطلب با اندازه اثر سنجیده باشدمین توجهقابلهمواره به معنی اثرگذاری  داریمعنی . 

 d  کوهن(Cohen’s d برای )رودمیاثر بکار  محاسبه اندازه. 

 

 ۳8نکته  □
 کوهن dیم آماری: مفاه

دو گروه  اریانحراف مع چنانچه .شوندمیشناخته  ادیاندازه اثر کم، متوسط و ز بیبه ترت 8/0و  9/0، 2/0

 ریکوهن به شکل ز dباشد، در آن صورت  -88/۷هاآن نیانگیو تفاوت م ۱۹/9و  68/9 بیبه ترت ییتا ۹3و  ۹2

 :شودمیمحاسبه 

 معیارها:الف( محاسبه میانگین وزنی انحراف 

(5.484 ∗ 12) + (5.911 ∗ 13)

12 + 13
= 5.706 

 کوهن: dب( تعیین 

Cohen’s d=
−7.878

5.706
=-1.38 

 طورهبمیانگین مشاهدات گروه اول بیش از یک برابر انحراف معیار از گروه دوم کمتر بوده و اندازه اثر 

 ی بزرگ است.توجهقابل

 

 ۳9نکته  □
 : اندازه اثر )نکات(یآمار میمفاه

  باشد. تواندمیمداخلات حیاتی اندازه اثر کم، بسیار با ارزش در 

  شودمیاندازه اثر با هزینه انجام مداخله مقایسه. 

  متغیرها توصیه شده است. داریمعنیگزارش اندازه اثر در نتایج تحلیلی آمار استنباطی هنگام 
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 ۴1نکته  □
 توان آماری :مفاهیم آماری

 ( توان آماریStatistical Power میزان قدرت آزمون در تشخیص بین صحت یا اشتباه بودن فرض صفر )ا ر

 .کندمیتعیین 

  باشدمیاندازه اثر و حجم نمونه  تأثیرتوان آماری تحت. 

   آن را  به صحت فرض یا پائین بودن توان آماری نسبت داد. توانمیچنانچه فرض صفر رد نشود 

 

 ۴1نکته  □
 یعمل ی: تساویآمار میمفاه

 میدانی نتیجه اهمیت داشته باشد، در آن صورت موضوع تساوی عملی  اجرا پذیریانچه چن(Equivalence )

 .گرددمیمطرح 

  شودیمو گزارش  نشدهپذیرفته، داریمعنیبا عدم تأمین حداقل میزان اندازه اثر مورد نیاز، روش جدید با وجود 

 تساوی عملی وجود دارد. 

 

 ۴۲نکته  □
 )نکات( یعمل یاو: تسیآمار میمفاه

 تفاوت عملی وجود  هاروشمیان  شودمیباشد، گزارش  8/0توان آماری برای اندازه اثر مطلوب حدود  چنانچه

 ندارد.

  ارزشمندی روش  شودمیهست، گزارش  0/9اگر توان آماری مورد نیاز برای اندازه اثر درخواستی کمتر از

 .باشدمیجدید هنوز نامشخص 

 

 ۴۳نکته  □
 نا پارامتریپارامتری و  هایآزمون :آماریمفاهیم 

 هایآزمون ( پارامتریParametric و )نا پارامتری (Non Parametric.جزء آمار استنباطی هستند ) 

 دارند. نا پارامتری هایآزمونپارامتری توان آماری بیشتری نسبت به  هایآزمون 

 کمتری نیاز دارند. هایفرضپیشبه  نا پارامتری هایآزمون 
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 ۴۴نکته  □
 لازم( طی)شرا یپارامتر هایآزمون: یآمار میمفاه

 اندشده گیریاندازهیا نسبی  ایفاصلهدر مقیاس  هاداده. 

  تصادفی، نرمال یا طبیعی هست.  هادادهتوزیع احتمالی 

 واریانس همسان(. باشندمیمورد مقایسه دارای واریانس برابر  هاینمونهیا  هاگروه( 

  وابسته به سطح متغیر مستقل نیست.، بینیپیشدقت 

 

 ۴5نکته  □
 IBM SPSSوارد کردن داده در 

  با فعال کردنSPSS  شودمی، ظاهر 3در رایانه ابتدا شکل. 

  ی قبلی از قسمت هافایلدر این مرحله امکان انتخابOpen another file   درRecent Files  یا وارد کردن

 وجود دارد. New Filesر د  New Datasetمستقیم داده با انتخاب 

  با انتخابNew Dataset  پنجرهData Editor  شودمیظاهر. 

 

 
 ی قبلی یا واردکردن مستقیم دادههافایل: نحوه انتخاب 3 شکل
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 ۴6نکته  □
 )مثال( IBM SPSSوارد کردن داده در 

  است. شدهیآورجمعنفر زن و مرد  60درآمد ماهانه 

  درآمد باincome و جنسیت با gender .مشخص شده است 

 باشدمی( 2و  ۹ی درآمد، نسبی و جنسیت، اسمی )هاداده. 

 ی مورد نظر در فایل هادادهdataentry.sav.آمده است ، 

  نمایی از 6شکل ،Variable View باشدمی . 

 

 
 ی مورد بررسیهاداده هایویژگی: معرفی 6شکل 

 

 ۴۷نکته  □
 (Descriptive Statistics)آمار توصیفی 

  هاچارکمعیارهای وضعیت نسبی: فراوانی، رتبه درصدی، صدک ها و 

  معیارهای گرایش مرکزی: میانگین، میانه و نما 

 معیارهای پراکندگی: دامنه تغییرات، واریانس و انحراف معیار 

  کجی: در توزیع متقارن کجی صفر هست. چنانچه دامنه توزیع به سمت راست پخش شده باشد، توزیع دارای

 ی مثبت و در حالت عکس، کجی منفی خواهد بود.کج

   باشدمیکشیدگی: بیانگر میزان بلندا و پهنای توزیع. 
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 ۴8نکته  □
 (Frequenciesفراوانی )

  ،شودمی بندیطبقهبا دستور فراوانی مقادیر متغیر. 

 ( در جدول فراوانی، فراوانی نسبیPercent( درصد معتبر ،)Valid Percent و درصد تجمعی )

(Cumulative Percent ارائه )شودمی. 

 شودمیاجرای دستور مراحل زیر انجام داده  منظوربه: 

Analyze → Descriptive Statistics → Frequencies 
 

 ۴9نکته  □
 فراوانی: تعاریف

  سازدمیفراوانی: تعداد مشاهدات هر مورد یا گروه را مشخص. 

  باشدیمی مفقود( هاداده جزبهی معتبر )کل مشاهدات هادادهدرصد معتبر: نسبت تعداد مشاهدات هر گروه به کل. 

  ی اسمی کاربرد ندارد.هادادهو برای  باشدمیاز درصدهای معتبر  ایپیوستهدرصد تجمعی: تجمیع 

 

 51نکته  □
 فراوانی: مثال

مشخص شده  genderجنسیت که با  CATEGORICAL VARIABLESیا  ایطبقهالف( برای متغیر 

 است.

 تعریف شده است. incomeدرآمد که با  QUANTITATIVE VARIABLESبرای متغیر کمّی یا ب( 
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 ایطبقهمتغیر  : تعریف9شکل 

 

 : نتایج۹جدول 

 
 

 51نکته  □
 )گزارش دهی( ایطبقهفراوانی: متغیر 

ه مفقود مشاهده . دادباشندمیمرد  نفر 20نفر زن و  20 هاآننفر بود که از میان  60تعداد نمونه مورد مطالعه 

نشده، لذا درصد معتبر با فراوانی نسبی تفاوتی ندارد. در مطالعه حاضر سهم زنان و مردان از نمونه مساوی و هر 

 .باشدمیدرصد  90یک برابر با 

 

 5۲نکته  □
 (QUANTITATIVE VARIABLESفراوانی: متغیر کمّی )

  فایلfrequencies.sav .را باز کنید 

 ( از منوی اصلیmain menu.مسیر زیر را انتخاب نمایید ) 



SPSS 

 

Analyze ➔Descriptive Statistics ➔ Frequencies 

  متغیرincome  را به پانل متغیر)ها( یاVariable(s) panel شکل زیر انتقال دهید. صورتبه 

 

 
 یکمّ ریمتغ یفراوان: 4شکل 

 

 Display frequency tables  .را انتخاب نمایید 

  دکمه(pushbutton )یا  هامارهآ Statistics.را انتخاب کنید 

  هاآمارهکادر گفتگوی (Statistics screen )شودمیشکل زیر ظاهر  صورتبه. 

 
 هاآمارهکادر گفتگوی : ۷شکل 
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  در سمت چپ و بالا زیر عنوانPercentile Values ،هاچارک (Quartiles را ).انتخاب نمایید 

 کزی یا سمت راست و بالا زیر عنوان گرایش مرCentral Tendency میانگین ،(Mean( و میانه )Median )

 را انتخاب کنید.

   زیر عنوان پراکندگی یاDispersion( انحراف معیار ،Std. deviation( حداقل ،)Minimum حداکثر ،)

(Maximum( و انحراف معیار میانگین )S.E. mean.را انتخاب نمایید ) 

  زیر عنوان توزیع یاDistribution کجی یا چولگی ،(Skewness ) و کشیدگی(Kurtosis ) را انتخاب

 کنید.

 5۳نکته  □
 (chartsفراوانی: نمودارها )

  دکمه ادامه یا هاآمارهدر کادر گفتگوی ،Continue  اصلی ) یگفتگورا انتخاب نمایید تا به کادرmain 

dialog window ).بازگردید 

 ( دکمه نمودارهاChartsرا انتخاب و در ) پنجره ( نمودارهاCharts window( هیستوگرام ،)Histograms )

 .نمایید

 

 
 پنجره نمودارها: 8شکل 
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  با انتخاب دکمه ادامه یاContinue  اصلی گفتگو برگشته و سپس با تائید  پنجرهابتدا بهOK  تحلیل نتایج آغاز

 .شودمی

  صورتبهآمار توصیفی متغیر درآمد ( زیر در پنجره مشاهده گرViewer Window نمایش داده )شودمی. 

 

 آمار توصیفی متغیر کمّی: 2جدول 

 
 

 5۴نکته  □
 نیانگیم اریمع ی: خطایکمّ ریمتغ یآمار توصیف

( به ریشه Std. Deviation) هاداده( از تقسیم انحراف معیار Std. Error of Meanخطای معیار میانگین )

 :شودمی( محاسبه N( تعداد مشاهدات معتبر ) Square Rootدوم )

Std.  Error of Mean =
1.30745

√38
= 0.21210 

 

 55نکته  □
 خطای معیار میانگین: کاربرد

 فرضی تصادفی  هاینمونهی هامیانگینمعیار انحراف  خطای معیار میانگین، برآوردی ازN  باشدمیتایی از جامعه. 

  شودمیتوزیع احتمالی میانگین، نرمال فرض. 

 خطای معیار میا( نگین در محاسبه فاصله اطمینانConfidence Interval.کاربرد دارد ) 
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 56نکته  □
 خطای معیار میانگین: مثال

 :شودمیزیر محاسبه  صورتبهدرصدی برای میانگین درآمد  ۱9فاصله اطمینان 

Lower confidence value=6.415- (1.96*0.2121)=5.9993 

Upper confidence value= 6.415+ (1.96*0.2121)=6.8307 

 خطای معیار میانگین است. 2۹/0میانگین درآمد و   6۹/4درصد بوده و  ۱9برای  zمقدار  ۱4/۹

 

 5۷نکته  □
 خطای معیار میانگین: تحلیل

 ( سطح پائین اطمینانLower confidence value( و سطح بالای اطمینان )Upper confidence value )

 .باشدمی 83/4و  ۱۱/9درآمد به ترتیب برای میانگین 

  قرار خواهد گرفت.  83/4الی  ۱۱/9درصد موارد میانگین در فاصله  ۱9انجام شود در  دفعاتبه گیرینمونهچنانچه 

 

 58نکته  □
 توضیح :کجی

  کجی یاSkewness  دهدمیمیزان عدم تقارن توزیع را نشان. 

  باشدمیمنحنی نرمال دارای کجی صفر. 

  کوچک باشند، کجی مثبت ) اعداد نمونه چنانچه بیشترPositive Skewness( و دنباله توزیع )The “tail” 

of the distribution به سمت مقادیر مثبت محور )X .خواهد بود 

 

 59نکته  □
 مثال :کجی

 ( اگر بیشتر اعداد نمونه ارقام بزرگی هستند، کجی منفیNegative Skewness و دنباله توزیع به سمت )

 خواهد بود.  X منفی محورمقادیر 

  ،که بیانگر کجی منفی توزیع احتمالی است.  باشدمی  -/0۹8کجی متغیر درآمد 
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 61نکته  □
 توضیح :کشیدگی

 ( کشیدگیKurtosis( میزان فشردگی )Compression( یا پهنی )Flattening توزیع را نسبت به منحنی )

 .سازدمی( مشخص Normal Curveنرمال )

 بوده و  کشیدگی منحنی نرمال صفرmesokurtosis  شودمینامیده . 

 

 61نکته  □
 مثبت کشیدگی

 (  کشیدگی مثبتPositive Kurtosis هنگامی است که توزیع نسبت به منحنی نرمال حول مرکز فشردگی )

(more compressed toward the center.بیشتری دارد ) 

  ،کشیدگی مثبتleptokurtosis  شودمینامیده. 

 

 6۲نکته  □
 یمنف یدگیکش

  کشیدگی منفی شودمیباشد، گفته  ترپهنزمانی که توزیع نسبت به منحنی نرمال (Negative Kurtosis )

 وجود دارد.

   کشیدگی منفی به نامplatykurtosis    شودمیشناخته. 

  محاسبه شده است.  -۱4/0کشیدگی مثال فوق 

 

 6۳نکته  □
 کشیدگی: تحلیل

  توزیع بیش از اندازه کشیدگی ندارد. شودمیباشد، گفته  +۹تا  -۹چنانچه کشیدگی در فاصله 

  باشد، محققین از عبارت  +9/0تا  -9/0اگر کشیدگی در فاصلهa bit of compression  برای توضیح وضعیت

 . کنندمیاستفاده 

  واژه ۹یا  -۹برای کشیدگی +mild compression .کاربرد دارد 
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 6۴نکته  □
 کشیدگی: مثال

 باشدمی ترپهناست، لذا کشیدگی منفی داشته و نسبت به محنی نرمال  -۱4/0 درآمد  کشیدگی متغیر. 

  ،0/۱4۹−)درصدی، دامنه پائین  و بالای آن  ۱9است که در فاصله اعتماد  ۷9/0خطای معیار کشیدگی ±

۹/۱4 ×  خواهد بود. 9۹/0و  -63/2(، 0/۷90

 

 

 : هیستوگرام۱شکل 
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 : جدول فراوانی3جدول 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 65نکته  □
 آمار توصیفی متغیر کمّی: گزارش دهی

هستند. میانگین مشاهدات  (Missingمورد مفقوده ) 2( و Validمورد معتبر ) 38، شدهآوریجمعنمونه  60از 

دی درص ۱9حد پائین و حد بالای فاصله اعتماد  02۹/0که با توجه به خطای معیار میانگین  باشدمی  6۹/4معتبر 

. کجی متغیر باشدمی 3۹/۹ هاآنبوده و انحراف معیار  43/4میانه مشاهدات خواهد بود.    83/4و   ۱۱/9به ترتیب 

قرار گرفته است( ولی با  ±۹)در محدوده  باشدمیوده که بیانگر تقارن نسبی توزیع احتمالی ب -0۹8/0درآمد، 

 .باشدمی ۱و  63/6نیز به ترتیب  هادادهثر ، کشیدگی منفی، محسوس هست. حداقل و حداک-۱4/0کشیدگی 

 

 66نکته  □
 (Descriptivesی توصیفی )هاآماره

 هاآماره( ی توصیفی برای متغیرهای کمّیQuantitative Variables.کاربرد دارد ) 

 فراوانی متغیر کمی :1 یویدیو

 drshahnavazi@در سی دی و کانال تلگرام  دسترسقابل
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 درصدها  جزبهی این قسمت هاآماره(Percentiles ) هاگرافو (Graphic Output مشابه قسمت فراوانی )

(Frequencies.است ) 

  به مقادیر استاندارد وجود دارد. رهایمتغامکان تبدیل 

 

 6۷نکته  □
 ی توصیفی: مثالهاآماره

  فایلfrequencies.sav .را باز کنید 

 ( از مسیر زیر متغیر درآمدincome.را انتخاب نمایید ) 

 Analyze ➔Descriptive Statistics ➔Descriptives 

  هاگزینهدکمه (Options pushbutton )برگزینید را. 

 ی میانگین، انحراف معیار، حداقل، حداکثر، خطای معیار میانگین، کشیدگی و کجی را انتخاب نمایید.هاآماره 

 

 
 : مسیر دستور آمار توصیفی۹0شکل 
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 : انتخاب متغیر آمار توصیفی۹۹شکل 

 

 
 ی توصیفیهاآماره: انتخاب ۹2شکل 
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 : نتایج توصیفی6جدول 

 
 

 68کته ن □
 ی توصیفی: تحلیلهاآماره

مورد معتبر بوده و حداقل و حداکثر آن به  38داده موجود  60گفت که از  توانمیبر اساس اطلاعات جدول 

بوده و دارای  3۹/۹انحراف معیار متغیر . باشدمی 2۹/0با خطای معیار  6۹/4هست. میانگین متغیر  ۱و 63/6ترتیب 

 یدگی منفی است.توزیعی به نسبت متقارن با کش

 

 

 

 

 69نکته  □
 اکتشاف

  فرمان اکتشاف یاExplore  کاربرد دارد.اندشدهآوریجمعمستقل  هایطرحی کمّی که از هادادهبرای ، 

  سازدمیمختلف را فراهم  هایگروهبه تفکیک  هادادهامکان توصیف. 

 :برای استفاده از امکانات این فرمان مسیر زیر را انتخاب نمایید 

Analyze ➔Descriptive Statistics ➔ Explore 

 توصیفی یهاآماره :۲ یویدیو

 drshahnavazi@سی دی و کانال تلگرام  در دسترسقابل
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 : مسیر دستور اکتشاف۹3شکل 

 

 ۷1نکته  □
 Statisticsاکتشاف: 

  در این قسمت حد پائین و بالای میانگین با انتخابDescriptives و تعیین فاصله اطمینان برای میانگین 

(Confidence Interval for Mean)  شودمیمحاسبه. 

  با انتخابPercentiles یا هاچارکاز صدک ها به همراه  ایمجموعه Quartiles  شودمیگزارش. 

 
 

 ۷1نکته  □
 Plotsاکتشاف: 

  ایجعبهدر این قسمت امکان ترسیم نمودارهای ( و ویسکرزbox and whiskers plot.وجود دارد ) 

 برد دارد.ی پرت و افراطی کارهادادهبرای بررسی نحوه توزیع و شناسایی  ایجعبه نمودارهای 

  معرفی شدند. ۹۱۷۷این نمودارها توسط توکی در سال 

 

 ۷۲نکته  □
 اکتشاف: اصطلاحات

  فاصله چارکی یاInterquartile Range (IQR)  ،  ام( با چارک سوم  29اختلاف مطلق چارک اول )درصد

 ام( است.  ۷9)درصد 



SPSS 

 

  9میانگین اصلاح شده ( 5درصدی% Trimmed Mean با حذف پنج درصد )از هر طرف محاسبه  هادهدا

 .شودمی

 Exclude cases pairwise  سازدمیامکان انجام محاسبه با حداکثر داده معتبر را فراهم . 

 

 
 : انتخاب متغیرهای اکتشافی۹6شکل 

 

 
 ی اکتشافیهاآماره: انتخاب ۹9شکل 
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 اکتشافی هایگراف: انتخاب ۹4شکل 

 

 
 اکتشافی هایگزینه: ۹۷شکل 
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 : نتایج اکتشافی9ل جدو

 
 

 ۷۳نکته  □
 )تحلیل( نتایج دستور اکتشاف: خلاصه

( مشاهده شده است. موارد Missingداده مفقوده ) 2( و Validداده معتبر ) 38نمونه مورد مطالعه،  60از 

ی هادادهدرصد محاسبه شده است. درصد  ۱0مفقود متعلق به گروه زنان بوده در نتیجه درصد معتبر این گروه 

 .باشدمیدرصد  0و  ۹0مفقود گروه زنان و مردان به ترتیب 

بوده و  48/9که میانگین درآمد زنان  دهدمیمختلف نشان  هایگروهی پژوهش به تفکیک هادادهبررسی 

و  49/9درصدی زنان و مردان به ترتیب  9. میانگین اصلاح شده باشدمی 08/۷کمتر از میانگین درآمد مردان با 

ی هاادهد، دلیلی بر عدم وجود توجهقابلکه تفاوت چندانی با میانگین اصلی ندارد. عدم وجود تفاوت است  ۹2/۷

 .باشدمی( Outlierپرت )

، یعنی باشدمی 9۷/6و در مردان  3ست در زنان هاداده( که بیانگر فاصله حداقل و حداکثر Rangeدامنه )

ی هادادهبوده و  02/۷و در گروه مردان  46/9در گروه زنان  پراکنش درآمد در مردان بیشتر از زنان است. میانه

 2. فاصله چارکی در زنان و مردان نیز به ترتیب دهندمیگروه زنان کجی مثبت و گروه مردان کجی منفی نشان 

 شده است.  68/۹و 
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 : نتایج آمار توصیفی اکتشافی9جدول 

 
 

 : صدک ها4جدول 

 
 

زنان و مردان به تفکیک محاسبه  هایگروه ۱9و  ۱0، 90، 29، ۹0، 9در ردیف نخست جدول صدک های 

ردیف دوم  دارند. 42/4درصد افراد، درآمدی کمتر از  29که  دهدمیام مردان نشان  29شده است. صدک 

ی پرت کاربرد اهداده( که در بررسی Tukey’s Hingesاول، دوم )میانه( و سوم توکی هستند ) هایچارک

 دارند.
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 : هیستوگرام زنان۹8شکل 

 
 : هیستوگرام مردان۹۱شکل 

 بیشتر در مقادیر پائین بوده، درنتیجه کجی مثبت هادادهکه فراوانی  دهدمیهیستوگرام گروه زنان نشان 

از منحنی  تردهیوابخو دامنه توزیع به سمت مقادیر مثبت است. کشیدگی توزیع نیز منفی بوده و  شودمیمشاهده 

 .باشدمینرمال عادی 
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ا نوع کجی ، لذباشدمی توجهقابلهیستوگرام گروه مردان رفتاری متفاوت داشته و فراوانی مقادیر بالا، 

 ازحدشیبمنفی و دامنه توزیع به سمت مقادیر چپ است. توزیع همچنین دارای کشیدگی مثبت بوده و ارتفاع آن 

 ی زنان و مردان چندان نامتقارن نیست.هادادهگفت توزیع  ودشمی. با احتیاط باشدمینرمال 

 

 
 ایجعبه: نمودار 20شکل 

 

 ۷۴نکته  □
 )توضیح( ایجعبهنمودار 

( را مشخص The middle portion of the distribution)مستطیل وسط، بخش میانه توزیع 

طیل، وم برابر بوده و خط پررنگ درون مستاول و س هایچارکتقریبی با  طوربهآن . قسمت پائین و بالای سازدمی

 .شوندمی( نامیده Whiskers)ویسکرز  اندشدهبیانگر میانه توزیع هست. خطوطی که از دو طرف مستطیل خارج  

 

 ۷5نکته  □
 )کاربرد( ایجعبهنمودار 

  هادادهدر شناسایی  ایجعبهنمودار( ی پرتOutliers( و انتهایی )Extreme.کاربرد دارد ) 

 3تا  9/۹در فاصله  ایدادهانچه چن ( برابری فاصله چارکی قرار گیرد با دایرهO مشخص شده و بیانگر پرت بودن )

 داده است.

  شوندمیبرابر فاصله چارکی باشد، داده انتهایی بوده و با ستاره مشخص  3دورتر از  ایدادهاگر  . 
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 : شناسایی داده پرت2۹شکل 

 

 
 هایی: شناسایی داده انت22شکل 

 

 ۷6نکته  □
 )گزارش دهی( ایجعبهنمودار 

در گروه مردان بیشتر از  هادادهکه پراکنش  دهدمیزنان و مردان نشان  هایگروه ایجعبهبررسی نمودار 

حداقل مقدار یکسانی دارند ولی حداکثر درآمد در گروه مردان بیشتر است.  باآنکهگروه زنان است. هر دو گروه 

 .شودنمیداده پرت مشاهده  هاگروهاز  یکهیچدر گروه مردان بیشتر از گروه زنان بوده و در میانگین مشاهدات 
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 ۷۷نکته  □
 z: مقادیر استاندارد هادادهتبدیل 

  در قسمتDescriptives با انتخاب  توانمیSave standardized values of variables  مقادیر

 به نمود.( را محاسRaw Dataی خام )هادادهاستاندارد 

  مقادیرz،  سازندمیانحراف معیار از میانگین نمونه را مشخص میزان تفاوت داده برحسب. 

  مقادیر استانداردz  شوندمیاز رابطه زیر محاسبه: 

z = (X − M)/SD 

 . باشدمیانحراف معیار  SDمیانگین و  Mداده اصلی،  Xکه در آن  

 و مقدار منفی بیانگر کوچک بودن داده از میانگین هست. تربزرگمیانگین  ازکه داده  دهدمینشان  مقدار مثبت 

 

 ۷8نکته  □
 )مثال( z: مقادیر استاندارد هادادهتبدیل 

  فایلfrequencies.sav ( را باز کرده و از منوی اصلیmain menu ):مسیر زیر انتخاب نمایید 

Analyze ➔Descriptive Statistics ➔ Descriptives 

 د را به قسمت سپس متغیر درآمVariable(s)   ومنتقلSave standardized values of variables  را

 انتخاب نمایید.

 

 ۷9نکته  □
 )خروجی( z: مقادیر استاندارد هادادهتبدیل 

 خروجی اجرای دستور از دو قسمت تشکیل یافته است:

س بر اسا هادادهار که ی توصیفی شامل حداقل، حداکثر، میانگین و انحراف معیهاآمارهنخست؛ جدول 

 ، شوندمی، به مقادیر استاندارد تبدیل هاآن

 .شودمیاضافه  متغیرهابه فهرست  Zincomeدوم؛ متغیر 

 ی توصیفیهاآماره: ۷جدول 
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 : متغیر استاندارد23شکل 

 

 

 

 
 

 81نکته  □
 : رمزگذاری مجددهادادهتبدیل 

 توانمیف پژوهش متغیرهای اسمی و کمّی را با توجه به اهدا ( رمزگذاری مجددRecoding.کرد ) 

  شوندمیمتغیرهای اسمی بیشتر رمزگذاری مجدد. 

 تفاده اس هادادهبرای انجام محاسبات کافی نباشند، از این روش برای تجمیع  هاگروهتعداد اعضای  کههنگامی

 .شودمی

 متغیر استاندارد :۴ یویدیو
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  از روش  انتومیی کمّی برای مدیریت مشاهدات پرت ولی واقعی    هادادهدرRecoding  استفاده نمود و به

 اعداد قابل قبول اختصاص داد. هاآن

  دو روش کدگذاریrecode a variable into the same variable و recode a variable into 

a different variable وجود دارد. 

  استفاده از روشrecode a variable into the same variable  ی اولیه، توصیه هادادهبه دلیل حذف

 .شودنمی

  ی که بر حسب شهرستان هادادهی کدگذاری شده نیز کاربرد دارد، برای مثال هادادهرمزگذاری مجدد برای

 به تفکیک منطقه جغرافیایی، رمزگذاری مجدد نمود. توانمیرا  اندشدهکدگذاری 

 

 81نکته  □
 : رمزگذاری مجدد )مثال: داده کمّی(هادادهتبدیل 

 فایل Recoding ( شامل متغیر سنage( تعداد مراجعه به درمانگاه ،)visit( و محله سکونت )sector را باز )

 نمایید.

 ( از مسیر زیر متغیر سنage را به پنجره گفتگوی )رمز مجدد (Recode dialog window.بیاورید ) 

  متغیرage  را به کادرNumeric Variable ➔ Output Variable .منتقل نمایید 



SPSS 

 

 
 رمزگذاری مجدد یهاداده: 26شکل 

 

 
 هاداده: تعریف 29شکل 
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 : مسیر رمزگذاری مجدد24شکل 

 

 
 : تعریف نام متغیر برای رمزگذاری مجدد2۷شکل 

 
 : رمزگذاری مجدد28شکل 
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 8۲نکته  □
 (ایطبقه: رمزگذاری مجدد )مثال: داده هادادهتبدیل 

  فایلrecoding.sav  را باز کرده و( از مسیر زیر متغیر محله سکونتsector را به پنجره گفتگوی رمزگذاری )

 ( بیاورید.Recode dialog windowمجدد )

  متغیرsector  را به کادرNumeric Variable ➔ Output Variable .منتقل کنید 

 را شکل دهید. ۹( را در هم ادغام و طبقه 2( و میرداماد )۹ویلاشهر ) هایمحله 

 را ایجاد نمایید. 2( را در هم ادغام و طبقه 6( و دادگستری )3رجائی شهر ) هایمحله 

 را ایجاد کنید.  3( را ادغام و طبقه 4( و زعفرانیه )9الهی پرست ) هایمحله 

  

 
 ایطبقه هایداده: رمزگذاری مجدد 2۱شکل 

 

 

 

 

 

 

 

 داده کمی رمزگذاری مجدد :5 یویدیو
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 8۳نکته  □
 Visual binning : هادادهتبدیل 

 Visual Binningهایگروهکمّی به  هایدادهگری برای رمزگذاری مجدد ، روش دی ( مختلفBins )

 .باشدمی

 ( این روش، دیداریVisual نامیده )زیرا شودمی ،SPSS  با نمایش هیستوگرام متغیر، امکان مشاهده نحوه

 .سازدمیرا فراهم  بندیتقسیم

 Visual Binning و غیر از مواقع ضروری توصیه  شودمی هاداده، باعث از بین رفتن اطلاعات موجود در

 .شودمین

  بندیگروهدر این روش امکان ( بر اساس انحراف معیارstandard deviation.وجود دارد ) 

  −1 SD, 0 SD, and +1 SD 50 ,15.9به ترتیب معادل با صدک های, and 84.1, باشدمی. 

  بندیروهگ. در این نوع شودمیمختلف  هایاندازهی با هایگروهتشکیل  باعثرمزگذاری بر اساس انحراف معیار 

 . شوندمیمیانی متمرکز  هایگروهدر  هادادهبیشتر 

  پذیردمیبر اساس صدک ها انجام  بندیتقسیمبا تعداد مشاهده مساوی،  هایگروهبرای ایجاد. 

 

 8۴نکته  □
Visual binningمثال : 

  فایلrecoding.sav .را باز کنید 

 ر از منوی اصلی و مسیTransform ➔Visual Binning  متغیرvisit  را به قسمتVariables to Bin 

 .به پنجره اصلی وارد شوید Continueمنتقل نموده و با انتخاب 

 ( نام متغیر جدیدBinned Variable را تعریف و )را انجام دهید. بندیگروه 
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 : مسیر دستور رمزگذاری دیداری30شکل 

 

 
 برای رمزگذاری دیداری : انتخاب متغیر3۹شکل 
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 : پنجره اصلی رمزگذاری دیداری32شکل 

 

 
 برای رمزگذاری دیداری بندیگروه: انتخاب روش 33شکل 

 

 

 

 

 

 رمزگذاری دیداری بر اساس صدک :۷ یویدیو
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 85نکته  □
 محاسبه متغیرهای جدید : هادادهتبدیل 

 ( برای تک متغیرهاSingle Variable یا )ایمجموعه ( از متغیرهاSet of Variables کاربرد ).دارد 

 را محاسبه نمود. متغیرهایا ریشه دوم و میانگین  با استفاده از این قابلیت، محاسبات جبری انجام داده توانمی 

  شودمیپس از انجام محاسبات، متغیر جدید به انتهای فهرست متغیرهای موجود اضافه. 

  ،چنانچه محاسبه به دلایلی مانند وجود متغیر مفقود انجام نگیردsystem missing marker (a blank 

cell)  شودمینمایش داده. 

  برای محاسبه متغیر جدید از مسیرTransform ➔ Compute Variable  شودمیاقدام. 

 

 86نکته  □
 محاسبه متغیرهای جدید: عبارت جبری

  فایلrecoding.sav  را باز نموده و مقادیر استاندارد یاz متغیر age  را از رابطهz =
age−mean

SE
محاسبه  

 .نمایید

  باشندمی 93/24و ۱9/34میانگین و انحراف معیار به ترتیب. 

  نتایج را با محاسبه مستقیم مقادیرz .مقایسه نمایید 

  
 : مسیر محاسبه متغیر جدید36شکل 

 رمزگذاری دیداری بر اساس انحراف معیار :8 یویدیو
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 8۷نکته  □
 ضریب همبستگی پیرسون

 ( ضرایب همبستگیCorrelation Coefficientsشاخصی برای بررسی ن ) حوه ارتباط متغیرهای پژوهش با

 .باشدمییکدیگر 

  باشندمیضرایب همبستگی مختلفی قابل استفاده در علوم رفتاری، اجتماعی و پزشکی. 

 ( ضریب همبستگی پیرسونPearson Product Moment Correlation.پرکاربردترین ضریب هست ) 

 

 88نکته  □
 ضریب همبستگی پیرسون: فروض

  ًایفاصلهمتغیرها تقریبا ( هستندapproximately interval measurement.) 

 کنندمیتقریباً از توزیع نرمال پیروی  هاداده (approximately normally distributed.) 

  باشدمیپرت حساس  هایدادهضریب همبستگی پیرسون به. 

 

 89نکته  □
 ضریب همبستگی پیرسون: تاریخچه

  توسط  ۹8۱4ضریب همبستگی پیرسون در سالKarl Pearson .توسعه داده شد 

  این ضریب، ادامه کارهایSir Francis Galton  بود. ۹888و  ۹884 هایسالدر 

 

 

 محاسبه متغیر جدید )عبارت جبری( :9 یویدیو
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 91نکته  □
 هامحدودیتضریب همبستگی پیرسون: 

  دهدمیضریب پیرسون، درجه ارتباط خطی دو متغیر را نشان . 

  باشد مثلاً  غیرخطیچنانچه ارتباط دو متغیرU-shaped function  باشد، ضریب پیرسون شدت ارتباط را کمتر

 از میزان واقعی برآورد خواهد کرد.

  چنانچه رابطهU-shaped function  شودمیمتقارن باشد، ضریب صفر محاسبه. 

 

 91نکته  □
 ضریب همبستگی پیرسون: تحلیل

  باشدمی هاآنارتباط دو متغیر به معنای تغییر همزمان . 

  (.بینییشپد به معنای تغییر یک متغیر در نتیجه تغییر ایجاد شده در متغیر دیگر تفسیر شود )توانمیتغییر همزمان 

  توان دو ضریب همبستگی یا𝑟2 ( شدت ارتباطthe strength of the relationship, را مشخص )سازدمی. 

 

 9۲نکته  □
 مثال ضریب همبستگی پیرسون: ارتباط خطی

  متغیرهای  همبستگیضریبage و visit  در فایل دادهrecoding.sav  شودمیبررسی. 

  مسیرGraphs➔Legacy Dialogs➔Scatter/Dot  شودمیانتخاب. 

  نمودارSimple Scatter  دهیممیدر محورهای عمودی و افقی قرار  دلخواهبهانتخاب و متغیرها را . 

 
 : مسیر بررسی ارتباط خطی39شکل 
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 : انتخاب نوع ارتباط34شکل 

 

 
 : تعریف متغیرهای محورها3۷کل ش
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 : برازش خط رگرسیون38شکل 

 

 

 

 

 9۳نکته  □
 مثال ضریب همبستگی پیرسون: محاسبه

  از مسیرAnalyze➔Correlate➔Bivariate .برای محاسبه ضریب همبستگی اقدام نمایید 

  متغیرage  وvisit  را بهVariables Panel .انتقال دهید 

  با انتخابFlag significant correlations شودمیبا ستاره مشخص  داریمعنی . 

 

 

 

 

 

 بررسی خطی بودن ارتباط متغیرها :11 یویدیو
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 : نتایج ضریب پیرسون8جدول 

 
 

 

 

 

 

 9۴نکته  □
 ترینا پارام هایآزمونضریب همبستگی: 

  نا پارامتریچنانچه فروض ضریب همبستگی پیرسون تأمین نشود، استفاده از ضرایب همبستگی (non-

parametric correlation proceduresگرددمیری ( ضرو. 

 یاز به فروض کمتری ن هاآنو اجرای  کنندمی، پارامتر نمونه را با پارامتر جامعه مقایسه ننا پارامتری هایآزمون

 دارد.

  نیازی به نرمال بودن توزیع نیست. هاآزموندر این 

 

 95نکته  □
 بی-ضریب همبستگی: اسپیرمن و کندال تاو

  کاربرد دارد. ایرتبهو  ایطبقه هایدادهبرای  هاآزموناین 

 ( ضرایب همبستگی اسپیرمنSpearman rho.و کندال تاو )-( بیKendall tau-b جزو  ،)هایآزمون 

 هستند. نا پارامتریمعروف 

 ضریب همبستگی پیرسون :1۲ یویدیو
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  نا پارامتری هایآزموندر ( ارتباط میان متغیرها ضروری است یکنواختmonotonic relationship .باشد )

 .باشدمیارتباط خطی نوعی رابطه یکنواخت 

 

 96نکته  □
 ضریب همبستگی اسپیرمن

  ضریب همبستگی اسپیرمن ابتدا توسطSir Charles Spearman (1904) هایدهدا تأثیرکاهش  منظوربه 

 .پرت بر دقت ضریب همبستگی پیرسون معرفی شد

  ان ضریب مضریب پیرسون برآورد گردد، عدد حاصل ه هاآنچنانچه رتبه متغیرها محاسبه و سپس با استفاده از

 همبستگی اسپیرمن خواهد بود.

 

 9۷نکته  □
 ضریب همبستگی اسپیرمن: محاسبه

  سپس اعداد به توان دو رسیده و جمع شودمیدر محاسبه این ضریب ابتدا اختلاف رتبه هر جفت داده محاسبه .

 .شوندمی

 یابدمیکاهش  هاآنشده و ضریب همبستگی اسپیرمن  تربزرگبزرگ با توان دو  هایاختلاف. 

  (. بیشتر ارتباط و همبستگی) هست متغیرها رتبه بیشتر تشابه بیانگر باشد، نزدیک ±۹هر اندازه ضریب محاسباتی به 

 

 98نکته  □
 بی-ضریب همبستگی کندال تاو

 Maurice G. Kendall (1938, 1948) جایگزینی برای  عنوانبهبی را -ضریب همبستگی کندال تاو

  کرد. اسپیرمن معرفی بندیرتبه

  این ضریب سه نوعtau-a ،tau-b  وtau-c  دارد کهIBM SPSS  در قسمتBivariate Correlation 

 .کندمیرا محاسبه  tau-bتنها 
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 99نکته  □
 بی: تفسیر-ضریب همبستگی کندال تاو

 یه ر شبگفت مقادیر دو متغیر بسیا توانمی+ نزدیک باشد، ۹بی به -چنانچه مقدار ضریب همبستگی کندال تاو

 .اندشده بندیرتبهیکدیگر 

  معکوس متغیرها خواهد بود. بندیبهرتنزدیک باشد، بیانگر  -۹چنانچه ضریب به 

 .ضریب صفر نشانگر استقلال متغیرها هست 

 

 111نکته  □
 بی: مثال-ضریب همبستگی اسپیرمن و کندال تاو

  فایل دادهspearmankendall.sav .را باز نمایید 

  از مسیرAnalyze➔Correlate➔Bivariate  ضرایب همبستگی اقدام نمایید.برای محاسبه 

  متغیرimproving  )شاخص بهبود توان درمانی( وgender  )را به قسمت)جنسیتVariables  .انتقال دهید 

 

 : نتایج ضریب کندال و اسپیرمن۱جدول 

 
 

 111نکته  □
 بی: تحلیل-ضریب همبستگی اسپیرمن و کندال تاو

محاسبه شده که  93/0و  68/0ی به ترتیب در یک آزمون دوطرفه ب-گی اسپیرمن و کندال تاوضریب همبست

د احتمال اینکه ارتباط میان متغیر بهبو دیگرعبارتبه. باشندمی دارمعنیهر دو در سطح آماری یک درصد، 
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ر از زنان ن بهتدرمانی و جنسیت تصادفی یا شانسی باشد کمتر از یک درصد است و بهبود درمانی در مردا

 .دهدمیجواب 

 

 

 

 

 

 11۲نکته  □
 رگرسیون ساده خطی

 ( رگرسیون ساده خطیSimple Linear Regression و ضریب همبستگی پیرسون ارتباط نزدیکی با )

 یکدیگر دارند.

  بینیپیشضریب همبستگی میزان ارتباط متغیرها را مشخص نموده ولی رگرسیون، توانایی (Prediction یک )

 .سازدمییر بر پایه متغیر دیگر را میسر متغ

 

 11۳نکته  □
 رگرسیون ساده خطی: تاریخچه

  ابتدا توسط  ۹884فکر اولیه رگرسیون در سالGalton .مطرح شد 

 ( دو سال بعد موضوع همگراییCovariation( ارائه گردید که اکنون با نام همبستگی )Correlation )

 . شودمیشناخته 

 

 11۴نکته  □
 ون ساده خطی: متغیرهای مستقل و وابستهرگرسی

  شودمی بینیپیشدر رگرسیون، متغیری که (Being Predicted( را متغیر وابسته )Dependent یا خروجی )

(Outcome )و معمولاً با  نامندمیY  دهندمینمایش  . 

  بینیپیشمتغیر دیگر که برای (Predict استفاده )شودمی ( را مستقلIndependent)  کننده  بینیپیشیا

(Predictor نامیده و با )X  کنندمیمشخص. 

 

 ضریب همبستگی اسپیرمن و کندال :1۳ یویدیو
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 115نکته  □
 گذارینامرگرسیون ساده خطی: 

  نامندمیرگرسیون ( زیرا مقادیر متغیر وابسته با استفاده از یک الگوModel )شودمی بینیپیش. 

  شودمیاستفاده  بینیپیشزیرا تنها از یک متغیر برای  باشدمیساده. 

  است زیرا ضرایب الگو خطی هستند.خطی 

 

 116نکته  □
 رگرسیون ساده خطی: مثال

 فایل recoding.sav .را باز کنید 

  از مسیرAnalyze➔Regression➔Linear ( وارد شده و متغیر مراجعه به درمانگاهvisit را به قسمت )

Dependent ( و متغیر سنage را به قسمت )Independent(s) .منتقل نمایید 

  قسمت درStatistics ی هاگزینهModel fit ،Descriptives  وPart and partial correlations  را

 انتخاب نمایید.

 

 

 : مسیر دستور رگرسیون3۱شکل 

 

 رگرسیون: نتایج ۹0جدول 
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 11۷نکته  □
 رگرسیون ساده خطی: تحلیل

ین نشده است. ا دارمعنی طرفهیکضریب همبستگی پیرسون متغیرهای سن و تعداد مراجعه در یک آزمون 

محاسبه شده که با  03/0ضریب متغیر سن،  کهنحویبه، شودمیموضوع در الگوی رگرسیون خطی نیز مشاهده 

 تأثیرسن  دیگرعبارتبهنیست.  دارمعنیدرصد  9که در سطح  شودمی۹8/0مربوط  t، آماره 02/0خطای معیار 

 انی ندارد.بر تعداد مراجعه به مراکز درم  داریمعنی

 

 

 

 

 

 118نکته  □
Centering the Predictor Variable 

  غیرمعمولچنانچه صفر عدد (Unusual( یا غیر معتبر )Not valid ) کننده  بینیپیشبرای متغیر مستقل یا

(Predictor باشد، از تکنیک )Centering  مدل رگرسیون استفاده  مبدأبرای مفهوم بخشی به عرض از

 .شودمی

 Centering  گذاردنمیتأثیری بر نتایج رگرسیون. 

 

 119نکته  □
Centering محاسبه : 

 Centering  که دارای میانگین صفر باشد، هست. ایگونهبهتبدیل متغیر اصلی 

  هادادهاین عمل با محاسبه انحراف ( از یک عدد مرجعReference Score مانند میانگین انجام )گیردمی. 

  صورتبهرابطه مورد استفاده (Deviation Score = Obtained Score−Mean.است ) 

 

 

 

 رگرسیون ساده خطی :1۴ یویدیو

 drshahnavazi@در سی دی و کانال تلگرام  دسترسقابل
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 111نکته  □
Centering مثال : 

  ارتباط میان شاخص توده بدنی(Body Mass Index یا )BMI  و ضربان( قلبPulse Rate بررسی )

 .شودمی

 ( شاخص توده بدنی در تشخیص اینکه آیا فرد اضافه وزنOverweightدارد یا خیر کاربرد د ).ارد 

 Adolphe Quetelet  توسط  ۹۱۷2معرفی کرد و در سال  ۹832این شاخص را در سالAncel Keys ،

BMI  .نامیده شد 

 BMI  .نسبت وزن به کیلوگرم به توان دو قد به متر هست 

 زیر است: صورتبهشاخص توده بدنی  بندیطبقه 

  9/۹8کمتر از ( لاغرUnderweight بین ،)۱/26تا  9/۹8 ( عادیNormal بین ،)اضافه وزن  ۱/2۱تا  29

(Overweight بین ،)۱/3۱تا  30 ( چاقObese و بیشتر از )60 ( چاقی مفرطMorbidly Obese )شدبامی. 

  با افزایش شاخص توده بدنی ریسک سلامت(Health Risk افزایش )یابدمی. 

  ریسک سلامت، ضربان قلب  هایشاخصیکی از(Heart Rate ).است 

 ًضربان قلب را دارد. بینیپیشتوده بدنی، توانایی شاخص  احتمالا 

 

 111نکته  □
 برآورد سنترینگ: مثال

  فایلBMI.sav .را باز کنید 

  میانگین متغیرBMI .را محاسبه نمایید 

  متغیر شاخص توده بدنی راCenter .کنید 

 ( رگرسیون ساده خطی بین متغیر ضربان قلبpulse_rate( و شاخص توده بدنی )BMIو شا ) خص توده بدنی

Center ( شدهBMI_centered را )جداگانه انجام داده و نتایج را مقایسه نمایید. طوربه 
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 شده سنتر : نتایج رگرسیون۹۹جدول 

 

 

 11۲نکته  □
 سنترینگ: تحلیل نتایج

در  در جامعه مورد مطالعه با افزایش یک واحد دهدمیبرآورد شد که نشان  ۱/0ضریب زاویه هر دو رگرسیون 

د صفر در . با جایگزینی عدشودمیمیانگین شاخص توده بدنی بر میزان ضربان قلب در دقیقه، یک واحد افزوده 

که بیانگر ضربان قلب افراد با میانگین  آیدمیبه دست  ۱/۷6مقدار متغیر شاخص توده بدنی سنتر شده، ضربان قلب 

 است. 2۱شاخص توده بدنی، 

 

 

 

 

 

 11۳نکته  □
 ی چند متغیرهرگرسیون خط

، باشدمیتوسعه رگرسیون خطی ساده  Multiple linear regressionرگرسیون خطی چند متغیره یا 

ضرایب برآوردی در رگرسیون  .هست predictorsکننده یا  بینیپیشمدل شامل دو یا چند متغیر  کهنحویبه

، زیرا در شوندمینامیده ( partial regression coefficientsخطی چند متغیره ضرایب جزئی رگرسیون )

 .متغیرهای دیگر دیده شده است تأثیر هاآنمحاسبه 

 . این اقدام با ایراداتیشودمی، الگوی خلاصه ارائه اندشدهن دارمعنیدر مواقعی با حذف متغیرهایی که 

 توانیمخطی را  رگرسیون متغیرها بر اساس مبانی نظری مطالعه باشد. حذفو لازم است حفظ یا  باشدمیهمراه 

 رگرسیون سنترینگ :15 یویدیو

 drshahnavazi@در سی دی و کانال تلگرام  دسترسقابل
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را حفظ  دارمعنیتنها متغیرهای  هاروش. این برآورد نمود stepwiseو  forward ، backward هایروش به

 .کنندمی

 

 11۴نکته  □
 رگرسیون خطی چند متغیرهی برآورد هاروش

  در روشforward  ظ گو حفشود، در ال دارمعنیمتغیرها یکی پس از دیگری وارد مدل شده و هر متغیری که

 . شودمی

  در روشbackward  متغیرهایی که توانایی توضیح دهندگی ندارند  تدریجبههمه متغیرها ابتدا وارد شده و

 . شوندمیحذف 

  در روشstepwise  برخلاف روشforward توانایی توضیح دهنگی متغیر کاهش یابد از الگو  کههنگامی

 .شودمیآن مجدد بررسی  تأثیرحذف شده و بعد 

 

 115نکته  □
Automatic Linear Modeling 

  ی اشاره شده، استفاده از روش هاروشروش جایگزین برایAutomatic Linear Modeling باشدمی. 

  این روش از تحلیلall-possible-subsets  کندمیاستفاده کرده و تمامی حالات مختلف را لحاظ. 

  چنانچهp تعداد متغیر باشد در آن صورت به تعداد (2𝑃)-1 9برای  مثالعنوانبهخواهیم داشت.  زیرمجموعه 

 وجود خواهد داشت. زیرمجموعه 3۹متغیر مستقل، 

 

 116نکته  □
 رگرسیون خطی چند متغیره: مثال

  فایل دادهMLR.sav  را باز کنید. این فایل شامل متغیرvisit  تعداد مراجعه به درمانگاه( و(age  )سن بیمار(

 .باشدمی

 ر جدید متغیageage  که توان دوage را ایجاد نمایید. باشدمی 

  رگرسیون چند متغیرهforward ،backward ،stepwise  وAutomatic Linear Modeling  را انجام

 دهید.

 .نتایج را تفسیر نمایید 
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 11۷نکته  □
 رگرسیون خطی چند متغیره: تحلیل

 ترینمناسبکه در هر چهار روش، رابطه درجه دو  سازدمیشخص ی مختلف مهاروشررسی نتایج ب

 30ا افزایش سن تا که ب ایگونهبه، باشدمیتعداد مراجعه به درمانگاه با استفاده از سن بیمار  بینیپیشالگو برای 

است که در الگوی رگرسیون خطی ساده  در حالی. این یابدمیسالگی تعداد مراجعه کاهش و سپس افزایش 

 رتباطی میان سن و تعداد مراجعه مشاهده نشد. ا

 

 118نکته  □
 رگرسیون خطی سلسله مراتبی

 ( رگرسیون خطی سلسله مراتبیHierarchical linear regression توسعه رگرسیون خطی چند متغیره )

یار کاربر اختسپرده شود، در  افزارنرماینکه به  جایبهبا این تفاوت که مدیریت وارد کردن متغیرها  باشدمی

 forwardرگرسیون  :16 یویدیو

 drshahnavazi@در سی دی و کانال تلگرام  دسترسقابل

 backwardرگرسیون  :1۷ یویدیو

 drshahnavazi@ در سی دی و کانال تلگرام دسترسقابل

 stepwiseرگرسیون  :18 یویدیو

 drshahnavazi@در سی دی و کانال تلگرام  دسترسقابل

 رگرسیون اتوماتیک :19 یویدیو
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 شوندمی( به ترتیب اولویت وارد الگو blocks) هابلوک( یا subsets) هازیرمجموعه. متغیرها در قالب باشدمی

 . شودمیبه همین خاطر روش، سلسله مراتبی نامیده 

  مپراش متغیرهای کمکی یا ه عنوانبه شوندمیوارد  ترشیپدر رگرسیون خطی سلسله مراتبی متغیرهایی که

(covariates برای متغیرهای بعدی عمل )ندکنمی. 

  ی موجود هاگزینهروش برآورد الگو را بر اساس  توانمیدر هر بلوکenter ،backward ،forward  یا

stepwise .جداگانه مشخص کرد 

 

 119نکته  □
 رگرسیون خطی سلسله مراتبی: مثال

 ن اطلاعات مربوط به وزن ثانویه، وز آوریجمعاقدام به  روش پرتودرمانی بر وزن بیماران تأثیرمطالعه  منظوربه

 بیمار گردید.  ۹0اولیه، جنسیت، سن، قد و روش معالجه برای 

  روش 3: جنسیت، سن و قد، بلوک2: وزن اولیه، بلوک ۹با تقسیم متغیرهای مستقل به سه بلوک )بلوک :

 ردید.پرتودرمانی( الگوی رگرسیون خطی به روش سلسله مراتبی برآورد گ

 

 : نتایج رگرسیون سلسله مراتبی۹2جدول 

 

 

 

 

 
 

 رگرسیون سلسله مراتبی :۲1 یویدیو
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 1۲1نکته  □
 دوحالتی تیلوج ونیرگرس

( از قبیل قبولی یا categorical) ایطبقه صورتبه( outcomeمتغیر وابسته یا خروجی ) کههنگامی

 باشدمیروه گ متغیر وابسته شامل دو کههنگامی. شودمیردی است از رگرسیون لوجیت یا لوجستیک استفاده 

 خواهد بود. binaryیا  ییدوتا، دوحالتینوع رگرسیون لوجستیک مورد استفاده، 

 


